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Preface: 
If you are a professional game developer or somewhat involved in two-dimensional (2-D) graphics production (for 

example, in digital data broadcasting work), you have probably have heard of this software named OPTPiX 

iMageStudio.  But you may not be sure about exactly what functions are available in this software or what kind of 

work it is mostly designed for.  Actually, we often hear people say presumably: 

 

“I know iMageStudio. It’s only a color reduction tool, isn’t it?” 

 

No it isn’t. Our iMageStudio is not only a color reduction tool. 

 

The iMageStudio is a “2-D Graphics Optimization Tool”,  

which improves efficiency of graphics designer’s work. 

 

OPTPiX iMageStudio is equipped with many functions. It has Palette Management necessary for game production, 

rich Alpha Channel Management functions, Compressed Image Editor supporting up-to-date full-color compressed 

texture and, of course, it features the powerful Color Reduction functions. 

In the field of game production and other creative information works, the weight of graphics has become more and 

more significant in recent years. Accordingly, graphic designer’s burden of work is growing heavier and heavier 

together with the increase of protocols of color specifications, image file formats and other requirements. When a 

new game platform is introduced, it features more expressive power than old machines. It means a lot of new 

requirements suddenly fell over to graphic designers, and they concurrently suffer a lot. 

 

To end this awful scene, you need some radical help from your computer to take care of messy routine works (except 

for drawing pictures, which is your own business).  For example, if your computer takes good care of color reduction, 

creating and keeping palettes, Alpha channels and texture images automatically, your productivity will improve 

dramatically. 

 

You can consider iMageStudio as a tool, which helps you manage this kind of “none-of-your-own-business” part. This 

part is however not essential to your art work, nonetheless inevitable. By using iMageStudio, large amount of 

expense for image management can be cut off from your game production field, and graphic designers can 

concentrate on their drawing work. 

In fact, this iMageStudio is used in many video games that are available today. This software is not showy or flashy 

as 3-D CG tools nor gigantic programming development tools, but it is surely needed and helps a lot for productive 

purposes. Generally speaking, the goal of iMageStudio is to provide total support environment for all of your image 

production, including game and broadband contents. 

 

Note: The text and captured images used in this tutorial document are based on iMageStudio Ver. 5.  You may find 

some difference in text or operation, if you use other version of iMageStudio. 
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What is OPTPiX iMageStudio? 

Introduction 
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OPTPiX iMageStudio is a powerful tool that provides 

comprehensive assistance to your 2-D Computer 

Graphics production. 

 

This software has accomplished a consistent status in 

games development, various multimedia programs 

development, and digital broadcasting contents 

production. The iMageStudio is arguably becoming a 

“must-have” tool for such contents production business. 

 

With intuitive user interface of iMageStudio, you can 

conduct various functions of e.g.: 

1) Color reduction in superior level of image quality; 

2) Delicate management of color palette; 

3) Rich variety of image adjustment and editing 

functions; 

4) Versatile batch processing, including automation of 

iMageStudio's useful functions without programming, 

operated by a single mouse click. 

 

The figure on this page shows a general workflow of 

iMageStudio use. This software can be used in many 

points in the workflow to process and modify materials, 

produced with e.g. Adobe Photoshop, for final output to 

game machine or other platforms. 
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Make sure that your development environments are properly set up. For example, when you are going to preview 

your images on development target machine using iMageStudio’s Remote Display feature, install those development 

tools first. 

 

Now, install the iMageStudio program. As the software is installed, a device driver for Hardware Key is also 

installed to your PC.  Connect your Hardware Key firmly to one of USB or parallel ports of your computer. 

 

 

 

 

After you have installed the iMageStudio, make a double 

click on the newly created iMageStudio icon on your desktop 

to start the application. 

 

At first, an iMageStudio logo splash will be displayed while 

the Hardware Key is verified. After the confirmation, an 

operation screen will appear (which will look like Figure 1). 

 

If an error is reported on Hardware Key verification, make 

sure that the Hardware Key is properly connected to your 

PC.  Please note: The system restrict to one Hardware Key 

to one licensed copy of iMageStudio software verification 

only.  Multiple copies of iMageStudio cannot share a single 

Hardware Key to start the programs. 

On the operation screen, you will see many windows, 

menus, operation buttons and other items.  But, don’t be 

overwhelmed!.  The operational scheme of iMageStudio is 

so simple and intuitive that you will get familiar with them 

soon after this short tutorial. 

 
<Figure 1> 

 

Getting Started 

Before launching iMageStudio program 

Starting iMageStudio 
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Besides the iMageStudio main window, you see a Menu Bar. This is the main menu of this application.   

 

A brief description of each menu in this Menu Bar: 

 

[File] menu contains menu items for file related operations. As you can see on Figure 

1, you can import and export image data. Scanner input and printer output 

operations are also available from this [File] menu, in addition to opening and saving 

image files. 

 
<Figure 1> 

 

[Edit] menu assembles functions for image editing and corrections (see Figure 2). 

This menu enables you to select a part/all of an image/a palette for copying and 

pasting, or switching edit mode. Undo operation (one of the operations you will likely 

to use the most frequently) is also available from this [Edit] menu. 

 

<Figure 2> 

 

Menu Bar 
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[Image] menu includes functions related to image size and image colors: e.g. Color 

Reduction, Tone Adjustment, and Resizing of image (see Figure 3). 

 

<Figure 3> 

 

In [Layer] menu, you can find layer operation menu items (see Figure 4). These layer 

functions of iMageStudio includes 1) layered image operations as Adobe Photoshop, 2) 

Link Layers, 3) Layer Animation and other useful functions for specific production 

fields (such as game development). 

 
<Figure 4> 

 

[Alpha] menu is for Alpha channel operations, which control transparency or opacity 

of image colors (see Figure 5).  The iMageStudio features rich Alpha channel 

functions, such as Color Reduction to keep transparency of image colors and image 

operations exclusive to Alpha channel.  This menu provides various Alpha channel 

editing functions necessary for vivid game scenes production. 

 

<Figure 5> 
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[Palette] menu is a collection of functions evolving color palette. The iMageStudio is 

equipped with various functions for you to smoothly perform palette work, which 

would be otherwise messy and inefficient. Other palette related functions, such as 

creation of palette color Gradation and Palette Animation Preview, can be also evoked 

from this [Palette] menu (see Figure 6). 

 
<Figure 6> 

 

[Filter] menu is in composed of a large number of image processing filters, such as 

Sharpen, Blur, Reverse Colors/Negative Image and many more variations (see Figure 

7). 

 
<Figure 7> 
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[Macro] menu (Figure 8) includes Macro functions that realize batch image processing 

by easy mouse operation.  Most of conventional software of this kind requires editing 

Macro program on text editor, but iMageStudio supports simple method for creating 

macros.  All you have to do is to select and fill in some dialog items. You can also check 

definitions for function keys, customize the function key definitions, and assign new 

Macro you have created to a function key. 

 

<Figure 8> 

 

[Options] menu enables you to set up various options of iMageStudio (see Figure 9). 

From this menu, you can choose environmental settings and other options such as pen 

size and pen shape for image editing. These options of iMageStudio are simply 

organized so that you can modify them quite easily.  For example, color reduction 

process has many complex options, but you will be navigated by dedicated window with 

visually apprehensive dialog structure. 

 
<Figure 9> 
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[View] menu is for switching display of various Tool Windows and synchronized display 

of related images, etc. (see Figure 10).  Remote Display to development tools (which is 

necessary on the final stage of production) can be also controlled from this menu. 

 
<Figure 10> 

 

From [Window] menu, you can issue commands to align or rearrange image windows as 

a whole (see Figure 11).  When you create game and other visual contents, your screen 

tends to be messed up with enormous amount of images processing simultaneously.  In 

that case, this [Window] menu will be very helpful to arrange those windows and tidy 

up your workplace.  
<Figure 11> 

 

Lastly, on the rightmost of the Menu Bar is the [Help] menu of displaying helpful 

instructions and operation manual.  When you are not sure about how to use 

iMageStudio, explore the help and you will get the right information explained here. 

Other information, such as current version of your iMageStudio or Plugin module, is 

available from the [Help] menu (see Figure 12). 

 
<Figure 12> 
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Now, let’s see the row of icon buttons under the menu bar. This is the Toolbar of iMageStudio for quick access to the 

most frequently used functions.  For example, there are buttons for creating new image, Undo operation, Zoom in, 

Zoom out, and toggle switch for Tool Windows display (see Figure 1). 

 

Place mouse cursor on one of these buttons and you will see a brief description of the button usage. Toolbar can be 

very useful alternative to menu operation. 

 

You can also add your favorite operation command to Toolbar.  To customize the Toolbar contents, select [Customize 

Toolbar] item from the [Options] menu (Figure 2). You can get rid of buttons you would never use and put more 

useful buttons into Toolbar (Figure 3). 

 

This tutorial includes no guide for the operations using Toolbar buttons but the standard operational methods 

through menu and window, as buttons on Toolbar can be freely exchanged and/or rearranged. 

 
<Figure 1> 

 
<Figure 2> 

 

<Figure 3> 

 

 

 

Take a look at the bottom of iMageStudio window. There is the Status Bar as 

shown in Figure 4. 

 

In this area, some useful information about currently active images, such as 

image size, image format and zoom ratio is shown. This is pretty useful when you 

are processing multiple images at the same time. 

 

 

<Figure 4> 

Toolbar and Status Bar 

Toolbar 

Status Bar 
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The Tool Bar and Status Bar can be independently turned ON to display or turned OFF to save space. To do that, 

check respective item in the [View] menu (see Figure 5 and Figure 6). 

 

 

<Figure 5> 

 

<Figure 6> 
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Basic Operations and Color Reduction 

Chapter 1 
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A concept called “color reduction” is a necessity for games 

production. As the name implies, this is a process to reduce 

color numbers used in an image. 

 

When you create a full color image using computer for a 

production work in, say a photographic advertisement field, 

you may freely choose one of 16 million colors for each pixel 

in that image.  In that case, 24-bit data will be required to 

make selections from 16 million colors. 

On the contrary, in the production field for video game 

consoles of the former generation, image color selection for a 

pixel was limited to 16 colors (4-bit) or 256 colors (8-bit). 

Those colors were not a fixed set of colors, however.  You 

could choose a set of 16 or 256 colors out of 30,000 (15-bit) or 

16 million (24-bit) colors. This scheme is called Indexed 

Color and a selected set of colors is called a Palette. 

In that kind of hardware platform, you have to take one of 

two strategies: (1) Create an image using a fixed color set of 

an existing palette. Or (2) create a full color image. Choose a 

small set of colors used in that image to make a palette. 

Then, replace all colors with the palette colors. 

Color Reduction is the final process of the latter strategy. 

 

For the new generation of video game consoles, however, the 

restriction to the use of full color images is relatively light 

and loose. You now have a freedom to use full color image. 

“Then”, you might think “we don’t need Color Reduction 

process for these games any more, right?”  Wrong! In the 

field of games production, you still need Color Reduction. 

On the new hardware platform, it is possible to directly 

handle full color images. But the traditional Indexed Color 

images can be handled more quickly and also in larger 

number than full color images. For instance, you can put 

three Indexed Color images of 256 colors in a memory space 

where you could put only one full color image of the same 

size. 

 

24-bit Full Color Image 

 

 

 

8-bit Indexed Color Image 

 

What does “Color Reduction” mean? 
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Indexed Color images will require Color Reduction, and “loss of image quality” always haunts you on account of 

Color Reduction process. You can see how much quality can be lost by simply process a full color image by Photoshop 

standard color reduction process. 
 
Here comes OPTPiX iMageStudio, the image processing tool dedicated to Color Reduction! Among other image 

processing and color reduction tools, iMageStudio is the most popular tool in this industry. Featuring its beautiful 

result out of Color Reduction, supreme Palette editing ability, and the powerful Macro (Batch) function, iMageStudio 

even automate those processes quite easily.  Thus, users choose this tool. 

Let's look into the basic features of iMageStudio for Color Reduction. 
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Follow the steps below for an example of Color Reduction process. 

 

 

The first step for a Color Reduction is to open an image file. 

 

Select [File] – [Open] menu item and see the File Open Dialog to choose 

which file to load (Figure 1). Pick up an image file and iMageStudio will open 

the specified file (Figure 2). 

 

You can open most image files in popular format such as PSD, BMP, PNG, 

TGA, etc. 

 

<Figure 1> 

 

 
<Figure 2> 

 

 

Now that you have opened a file, let’s check some basic points. 

 

You can identify an active image window by the color of its title bar. This is the 

common feature of standard Windows applications. In iMageStudio, most 

processes will be applied to the active window image. Make sure that the target of 

your important process is certainly the image you want to modify, not the other 

one! 

 

Please also note that iMageStudio is equipped with most basic operations found in 

popular image processing software. Direct drawing operation is possible in various 

drawing mode. You can zoom in and zoom out on the image. You can rotate or flip 

the image. These functions can be selected from [Image] menu, which include 

other image adjusting functions (e.g. Gamma, Level and Tone adjustment) just 

like those image processing tools. When you want to apply a little modification to 

an image, you don’t have to get back to Photoshop or one of those tools. You can do 

it with iMageStudio, too! 

 
Active Window 

 

 
Non-active Window 

Color Reduction in OPTPiX iMageStudio 

1. Open an Image File 

2. Active Window 
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Now is the time to try a real Color Reduction. The first example of Color 

Reduction process is a full color image with no Alpha channel. 

 

To apply Color Reduction to an active image, select [Color Reduction] from [Image] 

menu (Figure 3).  You can also click [Color Reduction] button in the Sub-Toolbar 

of the image window (Figure 4), or use a keyboard shortcut [Ctrl]+[R] of pressing 

Ctrl and R keys simultaneously. 

In any case, [Color Reduction] Dialog appears for you to set options for Color 

Reduction process.  Although this Dialog has a lot of options, iMageStudio 

remembers them all.  Once you have set your favorite options, you can apply the 

same Color Reduction efficiently with only a few steps of operation, from the next 

time on. Moreover, you can save current setting for Color Reduction or load other 

setting that you have saved before. 

 

As the contents of this Dialog are divided in separate pages (or Tabs), check them 

all and set necessary options. 

 
<Figure 3> 

 

 

<Figure 4> 

 

 

 

 

In this page, you can set Color Counts after Color Reduction and choose some 

options for how to reduce image colors. 

 

Larger number for [Output Colors] produces images of higher quality, but you 

may have to compromise in order to take advantage of "Color Reduction": 

smaller amount of image data. As a rule of thumb, you may take 256 colors for 

more advanced image quality or 16 colors for smaller size.  The exact number 

may depend on the purpose of the image. 

[Rendering Method] is important as it determines how to reduce colors. You can 

select [Adaptive Error Diffusion] method to get appropriate results for most 

ordinary images. This method is best for photographic images such as scenes of 

nature because it places special emphasis on smoothness. When you have to 

keep the file size small and Mach band is more or less negligible, you may try 

[None], meaning "no error diffusion". When you apply Color Reduction to 

cartoon-like image with visible gradation, try [Normal Error Diffusion] or 

[Ordered Dithering] to get better result. 
Small [Diffusion Level] will lower the fidelity of gradation. On the other hand, 

 

<Figure 5> 

3. Color Reduction and its Setting 

[Output] Tab 
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large [Diffusion Level] will produce rugged texture, though keeps granular dots 

of error diffusion visible. 

 

For the example here, let's choose [256 colors] for Output Colors, [Adaptive Error 

Diffusion] as Rendering Method, and [Minor (50%)] Diffusion Level (see Figure 

5). 

 

 

 

In this page, you can specify exactly what kind of nuance you want to preserve in 

images after Color Reduction process. 

 

[Balance]: controls the balance (weight of importance) between Brightness and 

Color. 

[Color Balance]: controls the balance between Red and Green. 

[Optimization]: controls the amount of computation for the selection of colors. 

 

For images with large amount of gradation, [Enhance largely-used Colors] option 

may produce better result.  Normally, you should keep [Apply Low-Pass Filter] 

OFF and [Palette Density] 24-bit (see Figure 6). 

 

<Figure 6> 

 

 

 

When you want to use an external palette for Color Reduction, [Use Fixed 

Palette] option in this page can be used to set up the palette configuration. This 

option is helpful for the following situations: 1) When the available color set is 

predefined; 2) When you need to add some extra color that cannot be selected 

automatically. [Use Fixed Palette] option is also good for applying “Color 

Reduction by same Palette” to multiple images in animation sequence or large 

scrollable background. 

 

For now, keep this option OFF.  There is no need ofsupplying any external color 

at this moment (see Figure 7). 

 

<Figure 7> 

 

[Optimization] Tab 

[Palette] Tab 
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The content of this Color Equalizer Tab varies depending on target platform. 

The Color Equalizer is quite handy to adjust Color Reduction results to the 

target-specific colors. However, you have to keep [Use Color Equalizer] option 

OFF when you create standard image of non-target machine dependent. 

 

For this time, keep the option OFF (see Figure 8). 

 
<Figure 8>

 

 

This page is exclusive to iMageStudio for Alpha supporting hardware platforms: 

other versions do not include [Alpha] Tab. 

 

You can use [Color Reduction with Alpha Channel] option in this page to include 

Alpha Channel in result Palette after Color Reduction. When you apply Color 

Reduction process to Indexed Color Image with Alpha Channel, two colors with 

the same RGB values but different Alpha values must be treated as two different 

colors.  Thus, you will need separate palette entries for each of these colors. 

Creating such palette would be quite knotty problem. Fortunately, iMageStudio 

has a splendid solution here for this problem. 

 

But keep this option OFF (see Figure 9) for now. Sample operation here uses 

images without Alpha Channel for Color Reduction. 

 
<Figure 9> 

 

 

In this page, you can choose some colors in an RGB value range as Transparent 

Area Color.  These colors will be assigned to Palette Entry 0 and will be excluded 

from Color Reduction process. 

 

The result image after Color Reduction can be displayed with the Transparent 

Area cut out (or seen through) by showing the color of Palette Entry 0 as 

transparent on the target machine. 

 

This time, turn OFF [Transparent Area Setting] option(see Figure 10), because 

transparent color is not used in the image here. 

 

<Figure 10> 

[Color EQ] Tab 

[Alpha] Tab 

[Transparency] Tab 
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In this page, select a Palette Sort order after Color Reduction.  

 

There are such standard orders as [YUV], [HSV], [HLS], as well as [RGB] in 

which you can change weight for R, G, and B components. iMageStudio original 

[Neuro] sort algorithm sorts colors in familiar way to human visual system, 

and [Alpha Value Order] is for Color Reduction with Alpha. 

 

Let's  take standard [YUV] option here(see Figure 11). 

 
<Figure 11> 

 

 

 

In these two pages, you can choose to apply some special processes, such as 

[Exchange Palette Entries after Color Reduction] for a post process (this is 

useful for images dedicated to Macromedia Director, see Figure 12), or assigning 

Black (0, 0, 0) to a fixed Palette Entry (in [Other] Tab, see Figure 13). 

 

Leave these pages as their default settings as they are not required for this 

time. 

 
<Figure 12> 

 

 
<Figure 13> 

 

[Sort] Tab 

[Post-Process] and [Other] Tabs 
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Now, let's click [Color Reduction] button to start processing.  With 

the default setting, nothing is happening for a moment, it may seem. 

But you will eventually see the image after Color Reduction in a 

newly created window. 

 

[Color Reduction] Dialog does not close itself.  So you can set up for 

the next Color Reduction process while processing is going on. You 

may execute a sequence of Color Reduction and varying its 

parameter little by little. Afterwards, you can also take enough time 

to scrutinize and compare the resulting images. 

 

These layout can be modified with a small button at the left of [Color 

Reduction] button, called [Open New Window] - [Continuative Color 

Reduction] (see Figure 14). 

 

<Figure 14> 

 

[Color Reduction] button 
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Let's take a look at resulting palette. You can see the Palette 

generated to fill the specified Output Colors in the Palette Editor 

window located on the right side of the image window (see Figure 15). 

 

* When you move mouse cursor on the image, a palette entry for pixel 

under the cursor will be shown with rectangular mark in the Palette 

Editor.  

<Figure 15> 

 

RGB and other color values of entries are listed in Palette Entry 

Window. These two windows are working together so that you can 

click an entry in Palette Editor to see the corresponding item in 

Palette Entry Window with high-light (see Figure 16). 

 
<Figure 16> 

 

 

Tip: How to handle RGB values in 15-bit Color Space 

When you want to handle RGB values in 15-bit (32 shades for each 

channel), you can turn [15-bit Color Mode] ON by clicking [15-bit] 

button on Sub-Tool Bar of the Image Window. (See Figure 17: On 

some versions for particular target platform, you may read [RGB565] 

instead of [15-bit].)  In this mode, RGB values that you can edit on 

Color Chart and Palette Entry Windows will be restricted to 15-bit 

values automatically. 

 

<Figure 17> 

 
 

4. Palette 
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Now the Color Reduction process is finished., Save the resulting image 

into a file. Select [Save As] item from [File] menu (Figure 18). 

 

A Dialog pops up to specify a file name and its type (format: see Figure 

19). After specifying a file to “save as,” click [Save] button to execute 

saving. Various File Saving Options can be also specified for several 

formats (see the four Dialogs on the bottom) before saving into such a file. 

 

You can also save palette data of an image. In order to do that, select 

[Save Palette] from [Palette] menu, or, select a “Palette Only” file format 

(such as ACT or BAP) in File Saving Dialog. 

 
<Figure 18> 

 

 
<Figure 19> 

 

With numerous file formats and automated saving process supported by iMageStudio, you may be required to 

prepare only one image material and adapt for various kinds of platforms and output methods. 

In this way, iMageStudio can be quite advantageous to image creation for advertising media, web material and 

multiple game platforms as well as a single game production alone, where the same image materials tend to be 

shared among these different fields these days. 

 

<BMP File Saving Dialog> 

 

<JPEG File Saving Dialog> 

 

<PNG File Saving Dialog> 

 

<MNG File Saving Dialog> 

 

 

5. Save 
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Tip: Important Color Area Selection 

 

Even more beautiful Color Reduction result may be obtained by using 

Important Color Area Selection procedure. Through this operation, you can 

specify colors of particularly important parts of an image to be treated more 

significantly than other colors currently used in that image. 

iMageStudio enables you to specify Important Color Areas intuitively and 

visually, whereas other standard tools requires numerical color information 

(palette entry numbers or RGB values). 

 

To start this procedure, click [Important Color Area Selection] button 

(marked with a cross on dotted-line circle) on upper right corner of Editing 

Mode Window (see Figure 1). 

 

Move your mouse cursor over the image. You will see that the cursor marker 

has been replaced with a new one, telling you that the Important Color Area 

Selection mode is turn ON. 

 

In this mode, go on to click some important areas where you want to weight 

the importance more than to other color areas in the image.  That will leave 

“white circle” marks put on -- or rather cut out of – the image, representing 

more significant colors are included in those “white circle” areas. 

 

Although you can assign many Important Colors by clicking here and there, 

their importance is not absolute measure here: they are relative.  You might 

end up with a faulty Color Reduction result if you choose too many Important 

Color Areas, spilling most important colors out of the selection. 

 

You can undo your last selection by right-clicking on an image area outside of 

any circle, or you can cancel a particular selection by a right-click on the circle 

representing it. 

 

Here, for example, Important Color Area Selections are selected by clicking 

on several complex areas of color gradation (see Figure 2). 

 

After the selection, apply Color Reduction process and check the result: what 

you see is what you get! 

 

<Figure 1> 

 

 
<Figure 2> 
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The following file formats are supported by iMageStudio: 

 

 

 

Load/Save Image Files 

(without Alpha) 

BMP, JPEG(JPG), PCX, PIX, RLE, TIFF 

Load/Save Image Files 

(with Alpha channel support) 

PIC(SOFTIMAGE3D), PICT(PCT), PNG, QBM, 

RGB(SGI), TGA 

Load/Save Image Files 

(with Multi-layer and Alpha channel support) 

IS, MNG, PDD, PSD 

Load Image Files 

 (without Alpha) 

2BP, DIB, J6I, MAG, MAKI, PBM, PGM, PI, PIC(X68K), 

PNM, PPM, Q0, RAS, WMF, XBM, XPM, XWD 

Note: IS and QBM are iMageStudio’s original file formats. 

 

 

 

 

 

Load/Save Palette Files 

(without Alpha) 

ACT 

Load/Save Palette Files 

(with Alpha channel support) 

BAP 

Load/Save Palette Files 

(with Multi-layer and Alpha channel support) 

ISC 

Note: ISC and BAP are iMageStudio’s original file formats. 

 

Other than the file formats listed above, your iMageStudio may also be able to load/save image files and palette files, 

depending on the particular target platform of the software. Moreover, various Plugin modules can be used to 

increase the numbers of supported file formats. 

Various Image Formats supported by OPTPiX iMageStudio 

Image File Formats 

Palette File Formats 
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Palette Operation 

 

Chapter 2 
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In the production field of game and other titles, it is essential that you can edit and operate Indexed Color Images. 

The production in Indexed Color environment, however, has many constraints you do not usually find in Full Color 

environment. The biggest constraint is that you have to use Palette. 

 

A Palette is the place where you keep colors used in an Indexed Color Image. It is a metaphor for painter’s palette, 

on which various color paints are kept for painting. As a painter selects and lays out on his/her palette a small set of 

colors from a large variety of his/her color paint collection, you select and lay out on your Palette a small set of colors 

that you really use in a image from a large variety of colors available on the target system. 

 

A Palette is not only for selecting and laying out colors. For instance, you can save two different Palettes and a single 

image in a file.  In this way, having only one image, you materialize "two pictures of exactly the same composition 

with different color layout". This is frequently used method to save memory space. 

 

Blinking lamp and burning fire, on the other hand, can be animated by modifying colors in a Palette real-time. In 

this case, you have to specify colors and their order in the Palette in order to modify the Palette contents from a 

computer program, when you create the original image and give the information to the program. If you handle 

Indexed Color Images in popular photo retouching software, however, you cannot specify palette entry position or its 

order freely. You need a dedicated graphics tool for that kind of operation. But then again, generally speaking, such a 

tool tends to lack expressive power and easy operation that you would expect from a standard graphics tool. 

 

When you tackle with Indexed Color Images, you want the power of a graphics tool optimized for Indexed Color 

Image editing: OPTPiX iMageStudio.  With this tool in your hand,  Color Reduction to a Full Color Image 

application for getting an Indexed Color Image with specified color number, adding palette entries for programming 

usage, and summing up all entries to get the final result are hassle-free. 

Other features, such as assigning multiple Palettes to a single image or sharing one Palette between multiple 

images, are quite powerful. These are also useful for "two pictures of exactly the same composition with different 

color layout"  by palette switching, or for animation preview. 

 

One other feature worth mentioning is the ease of Palette editing operation. 

For instance, such complicated processes can be handled freely and easily as: 

1) Exchange order of palette entries, 

2) Copy, paste and sort palette entries, 

3) “Scan palette entries that are sparsely used on the image side (less than 10 pixels). Integrate those entries with 

other similar entries to get vacant palette entries. Then, assign new colors to the vacant entries". 

 

This section talks about how to use Palette in iMageStudio. 

What is a Palette? 



- 29 - 

 

 

Your Palette will be displayed on the right hand of Indexed Color Image 

Window in iMageStudio (see Figure 1). This is called Palette Editor, in 

which you can specify Palette Entries to edit or execute Platte operations. 

 

The content of a Palette is also displayed on Palette Entry Window (see 

Figure 2) as a list of numeric data, representing RGBA values of each 

entry. 

 

The color of a Palette Entry that you select in Palette Editor or Palette 

Entry Window can be displayed on Color Chart Window (see Figure 3). 

In that case, you can instinctively change the color registered on a Palette 

Entry by operating Color Chart Window. 

 
<Figure 1> 

 
<Figure 2> 

 
<Figure 3> 

 

 

 

Palette Editor displays a lot of information, as well as colors currently registered 

on the Palette. 

 

Put the mouse cursor on the image, move it around and see what is happening on 

Palette Editor. A blinking little squire jumps here and there, pointing Palette 

Entry indexed by the pixel (under the current cursor position) of the image. In 

Figure 4, it is the Entry 255 on the bottom right corner. 

 

The Entries 0 to 137 have diagonal line, indicating that these entries are “vacant” 

or not used in the image. 

 

 

<Figure 4> 

Basic Palette Operations 

1. Palette Editor Display 
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If you click an entry in Palette Editor, the entry will be dented, indicating that 

the entry is currently selected. In Figure 4, the Entry 203 is the selected Palette 

Entry. 

 

You can select only one entry by one click. Clicking with [Ctrl] key pressed, 

however, you can select multiple entries one by one (see Figure 5). You can also 

select a sequence of consecutive entries by clicking on the start position and then 

clicking on the last position with [Shift] key pressed down (see Figure 6). 

 

The last entry that you have clicked on will be indicated by little squire with 

animating edges.  This entry is “focused” as the target of Palette Entry 

operation. 

 

 
<Figure 5> 

 

 
<Figure 6> 
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Once a palette entry or multiple entries have been selected, you can move them by mouse 

dragging operation: you can arrange palette entries instinctively. 

 

Drag a palette entry or entries. The mouse cursor will have an M mark followed by the 

moving palette entries (see Figure 7), while previously selected entries are shifted 

forward to fill the gap. 

 

Drag the entry to the position where you want it to be and release the mouse button. You 

will see the moving palette entry inserted to the release position, and palette entry 

motion completed. 

 

After a palette entry has moved, the entry order of the palette has been modified. In this 

case, iMageStudio will automatically replace index values of the image accordingly, 

immediately after the completion of palette entry movement, to keep the image 

consistent.  You don’t have to worry about the consistency of your Indexed Color Image 

regardless of palette entry arrangement. 

 

<Figure 7> 

 

2. Arranging Palette 
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Now, let’s examine the Palette Tool Window, the powerful toolbox for your palette 

operation. 

 

Palette Tool Window is a tiny window (even smaller than other compact tool windows of 

iMageStudio) but it holds essential 12 buttons (see Figure 8).  Let's see these tools one by 

one. 

 
<Figure 8> 

 

 

Click this button (Figure 9) to set up a condition, and select palette entries that 

satisfy the held condition. A Dialog will appear (Figure 10) for you to set up a 

condition. After you execute the Conditional Palette Entry Selection, only the 

entries that satisfy the condition will be selected (see Figure 11). 
 

<Figure 9> 

 
<Figure 10> 

 
<Figure 11> 

 

 

To fill the selected palette entries with a specified color, click this button (Figure 12) to 

pop up Dialog shown as Figure 13. After initializing Palette Entries, color of the 

selected palette entries will be modified (Figure 14).  
<Figure 12> 

 
<Figure 13> 

 
<Figure 14> 

3. Palette Tool Window 

Conditional Palette Entry Selection 

Initialize Palette Entries 
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To insert new palette entry at the focus position, click this button (Figure 15) to pop up 

Dialog shown as Figure 16. A palette entry will be inserted (see Figure 17). 

 

Note that the inserted entry is not exactly a new one: indeed, it is the last entry of the 

palette that has been moved to the focus position for making up an effect of inserting 

new entry.  As this function always modifies the content of the last entry, be careful! 

 
<Figure 15> 

 
<Figure 16> 

 

<Figure 17> 

 

 

 

To change the size of palette, click this button (Figure 18) to pop up Dialog shown as Figure 

19. After you have executed Resize Palette function, the total number of palette entry will be 

modified as shown in Figure 20. 

 

When you increase the palette size, new entries will be added to the bottom of the palette. 

When you decrease the size, entries at the bottom will be deleted, and the pixels indexing 

the deleted entries will be replaced with index values specified as [New Index for Deleted 

Colors] in the Dialog. 

<Figure 18> 

 
<Figure 19> 

 

<Figure 20> 

 

Insert Palette Entry 

Resize Palette 
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To sort palette entries by an order, click this button (Figure 21) to pop up Dialog shown as 

Figure 22. After sorting the palette, you will see something like Figure 23. 

 

As well as YUV and RGB sort orders also featured with Color Reduction, you can use such 

diverse orders as: 

1) [Reference Frequency] - sort palette entries by their usage (in order of occupied pixel 

counts), 

2) [Emerging Order] - sort entries by their encountered order as the image is scanned 

pixel by pixel from the top left corner, and 

3) [Reverse Order] - reverse the whole order. 

 

Note that this function can be applied to a set of selected palette entries, which may be out 

of sequence: for example, a column, not a row, can be sorted. 

 

<Figure 21> 

 
<Figure 22> 

 

<Figure 23> 

 

 

This function automatically deletes unused palette entries and integrates 

redundant colors in a palette. Click this button (Figure 24) to pop up Dialog shown 

as Figure 25. When you execute this function, palette entries will be arranged in the 

way you have specified in the Dialog (Figure 26 shows how unused entries are 

moved to the tail). 

 

<Figure 24> 

 
<Figure 25> 

 
<Figure 26> 

Sort Palette 

Arrange Palette 
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To replace index values assigned to the pixels of Indexed Color image with other index 

values, click this button (Figure 27) to pop up Dialog shown as Figure 28. When you 

execute this function, index values will be replaced with new values as shown in Figure 

29.  

<Figure 27> 

 

<Figure 28> 

 

<Figure 29> 

 

 

 

To generate gradation (smooth shade of color) on selected palette entries, click this 

button (Figure 30) to pop up Dialog shown as Figure 31. A gradation will be created on 

the selected entries (Figure 32) based on the originally assigned colors at the both end of 

the entries.  
<Figure 30> 

 
<Figure 31> 

 
<Figure 32> 

 

 

Replace Index Numbers 

Gradation 
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To shift colors of selected palette entries left or right, click this button (Figure 33) and a 

Dialog will appear as Figure 34. Execute this function to see the shifted colors as shown 

in Figure 35. As the name “Looped Shift” suggests, the colors that are shifted out from 

one side of entries will appear on the other side.  

<Figure 33> 

 

<Figure 34> 

 
<Figure 35> 

 

 

 

To check your Palette Animation, click this button (Figure 36) and set up the 

Dialog (see Figure 37). As defined by the Dialog, Palette Animation Preview 

function shows images in animation while switching palettes one after another. 

 

Three kinds of palette animation are supported by iMageStudio: [Multi-Palette] to 

switch multiple palettes in sequential order; [Block Shift] with which a palette is 

divided in several blocks and shifted one block after another; [Looped Shift] to 

rotate colors of the specified palette entries. 

 

<Figure 36> 

 

<Figure 37> 
 

<Figure 38> 

 

 

Looped Shift 

Palette Animation Preview 
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When you want to load a palette file to replace palette content, click this button 

(Figure 39) for Open File Dialog. Select a palette file and the file will be loaded as 

the palette content. 

 
<Figure 39> 

 

 

 

When you want to save current palette to a palette file, click this button 

(Figure 40) for “Save As” File Dialog.  Select a file name and file type, and 

the palette content will be saved to the palette file. 

 

<Figure 40> 

 

Load Palette 

Save Palette 
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As a practice, let’s do some palette arrangement, integrating of existing entries, assignment of new color and image 

color correction. Here, processing the image of Figure 1 as follows: 

 

(1) In order to assign a background dark-blue color as transparent color, move blue colors to the top of Palette. 

(2) To keep the similar color of pupil (also dark-blue) non-transparent, assign it to another entry. 

 

 

First of all, let’s gather palette entries for blue background to one place in this palette. 

 

Move the mouse cursor over blue background of this image.  A palette entry will be indicated on the Palette Editor, 

showing the entry used in the pixel pointed by the mouse cursor. 

 

You have to gather these entries by drag and drop operation. It is possible to drag and drop one entry after another. 

You can save some time and effort by selecting multiple entries using [Ctrl] key (Figure 1) and then drag those 

entries in one operation (Figure 2). 

 
<Figure 1> 

Select three blue colors of the background. 

 

<Figure 2> 

Drag palette entries. 

 

 

 

The procedure above would be quite simple and easy when you deal with a 

few palette entries. But when your target is a large part of image or a large 

amount of palette entries, you would certainly want to select entries used for 

pixels in specific area of the image automatically. In that case, use 

Conditional Palette Entry Selection. 

 

First, select an image area with rubber band: in this case, the blue part at the 

left top corner of the background. 

 
<Figure 3> 

Select entries for specific area. 

Palette Operations in Practice 

Gather Palette Entries for Background 

Gather Entries for Specific Image Area 
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Next, click Conditional Palette Entry Selection button in Palette Tool Window. 

At the Dialog as shown in Figure 3, select [Used in Selected Area] – [Yes] and 

click [OK] button. This will select all palette entries that are used in the 

pixels of the selected area of the image (in this case, three palette entries). 

 

Finally, as the Figure 2 of the former case, drag the selected palette entries to 

the top of the palette (see Figure 4). 

 

 

<Figure 4> 

Entries moved to the top of Palette. 

 

 

 

Before gathering entries at the top of the palette for specifying them to be 

transparent, make sure to leave out palette entries that should NOT to be 

transparent. 

 

In this case, select the top three entries gathered here and then hold down 

[Back Space] key.  The pixels using these entries will blink to indicate where 

in the image these colors are used. 

 

Notice that the pupils of the girl’s eyes, as well as the background, are 

blinking. If you make these three entries transparent, the pupils would 

become transparent. But, that is not what you want! The color of the pupils 

must be assigned to other than the background entries, although these are 

the same dark blue colors. 

 

<Figure 5> 

Pupils of the girls’ eyes are blinking 

together with blue background. 

 

 

 

Now, in order to register background and pupil blue colors as different 

entries, you have to create some new palette entries. But the 256 entries of 

this palette are all in use: there is no free (vacant, not-in-use) entry here. 

 

In this case, the best way to make some room for new entries is to pick up 

some entries of very similar colors and unify them into one entry. A quality 

loss of image might be inevitable when you integrate different colors. 

However, you can keep the loss obscure or even indistinguishable if the 

unified colors are nearly the same to human eyes or most of them are sparsely 

used in the image. 

 

 

<Figure 6> 

Select palette entries to unify. 

Check Where the Palette Entries are used 

Make some Vacant Palette Entries 
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So, let’s unify four white entries at the end of the palette here: that will make 

one white entry plus three vacant entries. 

 

First, select entries that you want to unify: in this case, select four 

consecutive entries near the end of Palette (see Figure 6). 

 

Next, click [Arrange Palette] button in Palette Tool Window to open its Dialog 

(see Figure 7). At the [Arrange Method] pane of this Dialog box, choose 

[Substitute with specified Index Number] option. The contents of image 

pixels, which is using the selected palette entries, will be replaced with 

“specified Index Number” specified by the spin box on the right (select 255 in 

the box so that the last entry will be used). 

 

As the four entries will be unified into one, the rest of three entries will 

become vacant. For the sake of visual discrimination, select [Arrange unused 

Entries] option, and choose [Initialize unused Entries] and [Black] 

parameters for [Post-Process]. 

 

Click [OK] button.  This will make the three vacant entries initialized to 

Black and the image pixels using those entries replaced with the index value 

255 (the last palette entry).  Finally, move the three vacant entries to 

position number 3 by dragging them with mouse operation (see Figure 8 for 

final result). 

 

<Figure 7> 

Arrange Palette Dialog. 

 

 
<Figure 8> 

Palette arrangement completed. 
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The next step is to copy background blue color to the new three entries. 

Select the new entries as Figure 3 and drag them with the right mouse 

button to the position of Entry 3. Then release the button to drop the copy. 

 

You will see a context menu to decide what to do with the dropped palette 

entries. As you are going to copy the color values of these entries, select 

[Copy Color Values] – [Copy RGB Values] from the context menu (see 

Figure 10). You will then see something like Figure 11, indicating a 

successful copy. 

 

The context of “Right-Dragging Palette Entry” operation features many 

other functions, such as [Exchange Palette Entry Locations] and [Exchange 

Color Values].  You should get familiar with these menu items if you want 

to edit Palette more quickly. 

 

<Figure 9> 

Before copying 

 

 
<Figure 10> 

Copy Color Values 

 

 

<Figure 11> 

After copying 

 

 

 

Finally, you have to replace index numbers (the colors of Indexed Color 

image) so that the pupils of the girl’s eyes, drawn with Palette Entries [0 – 

2], will be drawn with new entries [3 – 5].  A patient worker may do it by 

painstakingly hit over every dot in the pupils, but an iMageStudio expert 

will use [Replace Index Numbers] function to accomplish the same work in, 

say, just a ten seconds! 

 

So, let’s learn the trick. First, you select an image area as shown in Figure 

12.  This is a pre-process for “Replacing Index Numbers” only in the 

selected area.  Next, select Palette Entries [0 – 2], and drag them with 

Right mouse button to the position of Entry 3.  Release the button and you 

will see the context menu. Select [Replace Index Numbers] and then 

[Selected Area Only] from the menu (Figure 13). 

 
<Figure 12> 

Select the Area of her Eyes, including 

Pupils 

 

Copy Color Values of Palette Entries 

Replace Index Numbers of Palette Entries 
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The whole operation tells the iMageStudio to “replace the contents of pixels 

using index numbers to Entries [0 – 2] in selected image area with index 

numbers to Entries [3 – 5]!” 

 

Finally, check the result of the operation by selecting Entries [3 – 5] and 

then push down [Back Space] key. If ONLY the pupils are blinking, you 

have successfully replaced the index numbers: the background and pupils 

are using different palette entries of the same blue color. 

 
<Figure 13> 

Replace Index Numbers 

 

 

 

Back in the old days, when you were working with traditional tools. You had to get used to “rebuild a palette from 

scratch, and do the whole process of hitting all the dots again” routine work, which would require painstaking 

minutes for a master (maybe 15 minutes for an awkward worker).  With iMageStudio, however, it will take just five 

steps to do the same work. As a trained iMageStudio user, you will be able to do that in 15 seconds! 

 

Throughout this demonstration, you have learned how easily and freely you could edit Palette in iMageStudio: this 

is one of the major advantages of this software. 

Conclusion 
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Alpha, Multi-layer and Multi-Palette 

 

Chapter 3 
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When you produce an image as a printed picture, all your customers see is a two-dimensional set of pixel colors: no 

other information is needed. When you produce an image as an element for computer/video presentation, however, 

other information will be required as well as pixel colors. There are, to cite three, Alpha channel/value, Multi-Layer 

structure, and Multi-Palette structure. 

 

Alpha Channel:  

Most of computer graphics elements are represented in rectangular frames. For instance, imagine an animation of a 

human walking in front of a background picture. If the human images are surrounded by visible, opaque frames, the 

background picture would be always covered with the rectangular frame: what an awkward scene! You need some 

information or a rule that dictates “the figure is opaque and the other area is transparent” so that the presentation 

system can cut an overlay out of the frame and put it over the background image to compose a layered scene. 

 

In the old days of cartoon-like computer graphics, this problem was solved by a simple scheme that defines a 

“transparent color” (for example, BLACK=[0,0,0], WHITE=[255,255,255], GREEN=[0,255,0] or BLUE=[0,0,255])  

that represents transparent area, and all other colors are defined to be opaque. In this way, you paint the frame with 

“transparent color” so that the background picture can be seen through. 

 

Nowadays, however, you seldom see such a cartoon animation on video screen. Modern computer graphics platforms 

are equipped with Alpha values (or Alpha channel added to Red, Green and Blue channels) to represent 0 to 255 

opacity of each pixel: opacity 0 means an absolutely transparent pixel that completely shows the background pixel, 

opacity 255 an absolutely opaque pixel that completely hides the background, and other values representing a wide 

variety of semi-transparent pixel colors. If you are not quite sure about the effect, see a state-or-the-art CG movie or 

a latest video game. You will be stunned! 

 

Multi-layer Structure:  

Multi-layer structure keeps multiple images in one file. This is frequently used to represent a layered picture. There 

are many situations for which it would be handy to have something like a modeling picture of a car by separate 

images of its body, glass, and wheels. They are then combined together at the presentation time, rather than to hold 

them together in one image. If you are familiar with Adobe Photoshop, you should be quite sure about layered 

pictures and their big advantages. 

 

Motion of a walking human can be also presented by a multi-layer structure. You may draw a sequence of human (or 

super human) figures representing one full cycle of walking motion. In that case, it would be handy to put them 

together in a Multi-layer image file named “walker” or something, rather than to have multiple image files and keep 

track of them by calling their file names like “walker001”, “walker002”, etc. 

 

Image Editing Functions for Powerful Expression 
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Multi-Palette Structure:  

Multi-Palette structure can be used to keep multiple palette in one file, but it can be useful for other purposes. 

 

As mentioned shortly in the previous chapter, an Indexed Color Image can present quite a different picture by 

switching its palette. The set of palettes should be kept in a same place, preferably in a Multi-Palette file. 

 

Finally, Multi-layer and Multi-Palette structures can be combined in iMageStudio to share one or more palettes 

between multiple Indexed Color Images. This is handy for a game animation where it is necessary to have one 

palette for multiple Indexed Color Images.  

 

In this chapter, let's see how to use some of these features. 
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You can handle two different image types in iMageStudio: Direct Color Images and Indexed Color Images. Both of 

them can include Alpha information, but in quite a different manner. 

 

A Direct Color Image is also called Full Color Image.  This terminology is derived from the fact that each pixel 

contains its RGB values directly.  On the contrary, each pixel in an Indexed Color Image indirectly represents a 

color through Palette: a table of colors. 

 

A Direct Color Image can include the fourth channel called Alpha Channel, or A Channel, as well as R (red), G 

(green), and B (blue) Channels. Alpha Channel represents up to 256 levels of opacity for a pixel. 

 

A Palette of an Indexed Color Image can include the fourth value called Alpha value, as well as R, G, and B values. 

An Alpha value is in a range of up to 256 levels. Therefore, if an Indexed Color Image has two or more colors that 

have identical RGB values but different Alpha values, you have to assign separate Palette Entry to each of them. 

 

 

When you create a new image with Alpha, select [New Image] from [File] menu and turn 

[Add Alpha Channel] option ON (see Figure 1). 

 

When you want to add Alpha information to an existing image without Alpha, select [New 

Alpha Channel] from [Alpha] menu. 

 

<Figure 1> 

 

 

When you want to display Alpha information of an image, select [Display Alpha 

Channel] from [Alpha] menu.  The Image Window will become monochromatic: 

black part is the transparent area with lower Alpha, and white part is the opaque 

area with higher Alpha (see Figure 2, left). 

 

When you want to layer an image including Alpha information with other image 

or texture, select [Display Alpha-Blend Image] from [Alpha] menu. You can 

choose a background from [Solid Color], [2-Color Checked Pattern], [Background 

Image], or [Layer 1] (see Figure 2, bottom). 

 

<Figures 2> 

Alpha Channel 

“Alpha” in terms of iMageStudio 

Creating Alpha Information 

Displaying Alpha Information 
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When you draw on a Direct Color Image with Alpha Channel, you can choose to draw either 

on [RGB Channel Only], [Alpha Channel Only], or [RGB & Alpha Channel], by selecting a 

[Drawing Target] from [Options] menu (see Figure 3). 

 

Copy and Paste operation will be normally done with both RGB and Alpha channels. When 

you want to paste respectively to one or other channel, select [Special Paste] from [Edit] 

menu and choose one of the target channel selections shown on the Special Paste Dialog 

(Figure 4). 

 
<Figure 3> 

 

 

<Figure 4> 

 

 

When you edit an Indexed Color Image with Alpha Channel, you have to edit Palette data.  The direct channel 

editing as you do on Direct Color Images are not possible on indexed-color data structure. This is why “editing 

Indexed Color Image with Alpha Channel” is considered to be difficult. 

 

 

You should have already noticed that Color Reduction of an image with Alpha Channel will 

be a horrible work to do, because many palette entries might be required to hold a range of 

the same color with different Alpha values. As a matter of fact, only few such graphics tools 

handling such operation available in the world. 

 

Of course, OPTPiX iMageStudio does support Color Reduction with Alpha Channel. Its 

outstanding features include amazing balance of Alpha and RGB channels after Color 

Reduction, smooth shade of colors combined with subtle representation of 

transparency/opacity of Alpha Channel, and optimized Alpha values for each hardware 

platform. 

 

To apply Color Reduction to an image with Alpha Channel, visit [Color Reduction] Dialog, 

click on [Alpha] Tab, and turn [Color Reduction with Alpha Channel] switch ON (see Figure 

5). 

There are following options in the [Alpha] Tab page: 

 

<Figure 5> 

Editing Alpha Channel of Direct Color Image 

Editing Alpha Channel of Indexed Color Image 

Color Reduction with Alpha Channel 
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[Priority] adjusts the balance between RGB and Alpha values at the Color Reduction process: weighting RGB values 

will increase the color fidelity but it will be compensated with less Alpha value information. You must have some 

weight on Alpha side to keep transparency/opacity of the image. 

 

[Protect Transparent/Opaque Areas] option protects Alpha Channel of absolutely transparent area and fully opaque 

areas from smearing effect of error diffusion from neighboring semi-transparent area. If you also want to protect 

“nearly transparent” and “almost opaque” areas, turn [Enlarge Transparent/Opaque Range] switch ON. 

 

[Assign RGB value with weight on Alpha value] option lets iMageStudio assign less entries for colors with smaller 

Alpha values (lesser the opacity, lesser the color variation).  It is harder for human eyes to recognize the original 

pixel color as the pixel opacity gets closer to zero (transparent).  This option takes advantage of this visual 

phenomenon: the idea is to steal color precision from those areas and give it to other important areas. 

 

[No Error Diffusion in Alpha Channel] option prohibits error diffusion process while rendering Alpha values. This is 

useful for testing purpose where Alpha values must be increased or decreased linearly. 

 

Now, let’s get down to a practice. Here are two sample 

images (Figures 6) to present heaviest burdens for Color 

Reduction: one is a genuine 3-D CG (Three-Dimensional 

Computer Graphics) image and the other image includes 

Alpha-channel gradation with small relation to RGB 

channels! 

 
<Figure 6> 

 

Figures 7 are the first results came out from the default Color Reduction setting, [Priority] = 5 and all other options 

turned OFF.  You would appreciate a good job by this standard Color Reduction process, in spite of the difficult 

condition. 
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<Figure 7> 

By the way, did you notice the little monochrome bar below every entry in the Palette Editor? These bars represent 

Alpha values registered to the entries together with their respective RGB values. As the entries are sorted by YUV 

order, the same colors with alternate Alpha values are placed side by side. As you can see, several entries are 

assigned to one color with different Alpha values. 

The next pair of examples (Figures 8) is the result of options shown as Figure 5.  

On the left side window (RGB Channels), you may notice some black spots. This is a normal side effect of [Protect 

Transparent/Opaque Areas] option. These spots are in the “absolute transparent area”. Thus, they do not appear 

when the Alpha-blended image is displayed. So, it is a good idea to fill all these spots with one black color to save 

Palette entry slots for other colors. Indeed, you can see that more colors are used to represent the image smoothly. 

 

<Figure 8> 
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Finally, see Figure 9 showing how a Color Reduction with maximum priority on RGB Channels. The colors are very 

smooth but Alpha-channel gradation is now very poor. You can’t expect good image quality for Alpha blend display 

from this setting. The moral is: pay enough attention to set reasonable parameter values. 

 
<Figure 9> 
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Multi-layer structure is a data structure to hold multiple images in a file.  As you have already learned, 

iMageStudio can handle two types of images: Direct Color Images and Indexed Color Images. A multi-layer 

structure can hold either of the two types, exclusively or mixed together. 

 

 

 

When you want to compose a new layer, select [Add Layer] from [Layer] menu (see 

Figure 10). This will pop up a Dialog box, which is much the same with [New Image] 

Dialog. Click [OK] button and a new layer will be added to the current image. 

 

To delete a layer, select [Delete Layer] item from the [Layer] menu. 

 

<Figure 10> 

 

 

 

The bottom parts of a multi-layer image window are the Layer Tabs, each 

of which representing a layer of the image.  Click a Layer Tab and the 

corresponding layer will be displayed. 

 

Layer Tabs are initially numbered. But you can name them by double 

clicking each tab and typing Layer Name. Layer Names should be simple: 

you can see good examples in Figure 11. 

 

You can change the order of layers by dragging Layer Tabs. 

 

<Figure 11> 

 

 

Multi-Layer Structure 

Multiple Layers in iMageStudio 

Adding and Deleting Layers 

Layer Tabs 
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You can see what the alpha-blended image of multiple layers by 

Selecting [Blend Layers] from [Layer] menu.  At the Dialog as 

shown in Figure 12, click [Open Blend Image] button to open 

blended result of the image layers in a new window. 

 

You can also choose to blend layers directly from an image 

window.  Here is a Sub Tool Bar shortcut: click and hold the 

[Display Alpha-Blend Image] button; make a right-click to 

display the context menu; select [Alpha-Blend Method] and then 

[Blend All Layers] (see Figure 13). 

 
<Figure 12> 

 

 
<Figure 13> 

 

 

 

A layered picture can be animated by switching layers rapidly one after 

another. Click [Layer Animation] button in the Sub Tool Bar to pop up 

the Dialog shown in Figure 14. 

 

In this Dialog, you can control the duration and other display method 

for layer animation. Click [OK] button to see the animation: layers will 

be shown one after other automatically, like a high-speed slide show. 

 
<Figure 14> 

 

Blending Layers of an Image 

Layer Animation 



- 53 - 

 

 

 

 

Multi-Palette structure of iMageStudio can hold multiple Palettes in a file.  Using this feature, you can explore 

wide variety of images and Palettes combinations, such as one image having multiple Palettes, multiple images 

sharing one Palette, or even multiple images sharing multiple Palettes! Figure 15 is an example of Multi-Palette 

structure showing the same image with two different Palettes. 

 
<Figure 15> 

 

 

 

In order to handle Multi-Palette pictures in iMageStudio, you must switch 

the images to “Multi-Palette Mode” by clicking [Multi-Palette Mode] button 

in the Sub Tool Bar (Figure 16: you can also choose [Multi-Palette Mode] 

from [Palette] menu). This will pop up a Dialog shown in Figure 17, but you 

may usually skip options and click [OK] button to go into the Multi-Palette 

Mode. 

 

Editing Multi-Palette pictures involves some limitations not found in the 

case of ordinary pictures. Therefore, iMageStudio helps you by fail-safe 

operation for the Multi-Palette Mode. For example, because you can handle 

no Direct Color Image in Multi-Palette Mode, the mode can not be turn ON 

for an Image Window which includes one or more Direct Color Images. 

 
<Figure 16> 

 

 

<Figure 17> 

 

Multi-Palette Structure 

Multiple Palettes in iMageStudio 

Multi-Palette Mode 
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When you want to create a new Palette, select [Add Palette] item from 

[Palette] menu (see Figure 18). This will pop up a Dialog box, which is much 

the same with [New Palette] Dialog. Click [OK] button and a new Palette will 

be added to the current image. 

 

When you want to delete a Palette, select [Delete Palette] from [Palette] 

menu.  
<Figure 18> 

 

Adding and Deleting Palettes 
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The bottom parts of a Palette Editor in Multi-Palette Mode are the Palette Tabs, 

each of which representing a Palette (see Figure 19).  Click a Palette Tab and the 

corresponding Palette will be displayed in the Palette Editor. 

 

Palette Tabs are initially numbered but you can name them by double clicking each 

tab and typing Palette Name. Palette Names should be simple: you can see good 

examples in Figure 19. 

 

You can change the order of Palettes by dragging Palette Tabs. 
 

<Figure 19> 

 

 

 

Several assistance functions are provided for Multi-Palette Mode 

to handle pictures with multiple Palettes. These functions are 

grouped together as buttons in the Sub Tool Bar (see Figure 20; 

next to [Multi-Palette Mode] button), providing quick ON/OFF 

operation for the following functions: 

 

[Sync Palettes] is a function to synchronize entry position 

movement in multiple Palettes: if you move one entry in a 

Palette, the same entry in other Palettes will follow the 

movement and go to the same position. For example, if your 

Multi-Palette structure is consisted of two Palettes named 

“Reds” and “Blues” for switching over one image, moving one 

entry in “Reds” Palette (Figure 21) will cause the identical entry 

position movement in “Blues” Palette automatically (see Figure 

22).  

 

[Sync Layers] function is a logical extension of [Sync Palettes]. 

As explained in Chapter 2, moving Palette entry position will 

cause replacement of index values in the image (remember that 

pixel data are indexes in Indexed Color Images). The Sync 

Layers function automates this index value replacement in ALL 

layers (not only in the current layer of the image), when you 

move a palette entry in Multi-Layer Multi-Palette image. 

 

 

<Figure 20> 

 

 

<Figure 21> 

 

Palette Tabs 

Assistance Functions in Multi-Palette Mode 
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[Associate with Layer] is a function to associate Palette 

switching to Layer switching in a Multi-Layer Multi-Palette 

image. For example, imagine that you have a picture consists of 

five layers and three Palettes: Layer 1 and Layer 2 using Palette 

1, Layer 3 and Layer 4 using Palette 2, and Layer 5 using Palette 

3. In this case, if the [Associate with Layer] option is turned OFF, 

you would have to switch Palettes as well as corresponding 

Layers to be seen.  For instance,  switching to “Palette 2” for 

Layer 3, etc. When the [Associate with Layer] switch is ON, 

iMageStudio will switch Palette automatically as you switch 

layers according to the last Palette used for each layer from 

memory 

 

Multi-Palette Mode opens up a vast field of applications. You 

may require some time to determine which assistance function is 

most appropriate for the picture you are editing.  As you get 

used to these functions, however, your Multi-Palette life will 

become quite easy! 

 

<Figure 22> 
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A Multi-Palette picture can be animated by switching Palettes rapidly one 

after another. Click [Palette Animation Preview] button in the Sub Tool Bar 

to pop up the Dialog shown in Figure 23. 

 

In this Dialog, select [Multi-Palette] as the [Method] and click [Play] 

button. Palettes will be automatically switched one after another swiftly to 

play the Palette Animation in the Image Window.  
<Figure 23> 

 

 

 

To apply Color Reduction to a Multi-Layer image, visit [Output] Tab of 

[Color Reduction] dialog, turn [Process All Layers] option ON, and check 

[Create Common Palette for All Layers] option.  iMageStudio will 

compose one Palette that fits all the layers and use the Palette for Color 

Reduction of all layers.  The image after this Color Reduction process 

will be in Multi-Palette Mode. 

 

This method, called “Common Palette Color Reduction”, is very useful for 

Color Reduction of animation images. It is often convenient for an 

animated sequence of images to have a common Palette because it makes 

easy to animate a gang of characters wearing same shape of hats or hairs, 

a pair of eyes or shades, suits and boots in different colors.  All you have 

to do is to draw all required patterns of the animation character in Full 

Color images, bring them into iMageStudio to make a Multi-Layer Image 

of them, and apply the “Common Palette Color Reduction” to produce 

“Common Palette Animation Images” easily and automatically. 

 

Another technique for making “color-different” animation characters is to: 

(1) create an animated pattern of a character; (2) apply “Common Palette 

Color Reduction” on the images; (3) make many copies from the common 

Palette as required for characters; (4) modify Palette Entries for clothes 

and hair colors in each copy for different characters. 

 

<Figure 24> 

 

Palette Animation 

Color Reduction with Common Palette for All Layers 
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Exclusive Functions for Each Platform 

 

Chapter 4 



- 59 - 

 

 

Games platforms are equipped with various specialized functions for novel idea of visual effects or to minimize the 

use of memory space. Great effects can be achieved by using these special features properly, though there is almost 

no compatibility between different platforms.  When you create images for games, the most difficult thing is to 

produce images optimized to fully utilize those special functions which are unique to each of different hardware 

platforms. 

 

On many general-purpose graphics tools, you can’t expect optimized functions for the platform-specific hardware. As 

you can expect not much support from the makers of those tools, you are likely to choose a hard way to support 

yourself by developing your own tools or plug-in modules. 

 

Our iMageStudio is different: it is equipped with special functions carefully optimized for unique hardware features 

of each platform developed exclusively with compiled information from makers of those platforms. We also 

thoroughly adopt requests from key game makers of iMageStudio users and our own technologies acquired through 

may years experiences. With these built in specialized features, iMageStudio does propel your production of 

platform-specific image data. 

 

In this chapter, you will discover four of those specialized functions: MIPMAP creation, Color Equalizer, Remote 

Display, and S3TC/DXTC editing. 

 

Note: these functions are not supported on some iMageStudio versions for irrelevant platforms. 

Many Functions Specialized for Different Platforms 
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A MIPMAP is a set of identical images with different resolution. 

The multiple images of a MIPMAP will become necessary materials 

when the target picture is displayed in wide variety of sizes. 

Particularly for a small sized picture, it is more efficient to paste a 

small image in lesser shrinkage than to paste a big image in 

greater shrinkage.  

 

Imagine you are displaying a polygon in 3-D space. Further the 

polygon is, the smaller the display size of the polygon. For instance, 

a polygon at a short distance from the point of view might be 200 

dots of width, whereas the same polygon at a long distance from the 

point might be 16 dots of width. 

 

Now, think of pasting the texture shown in Figure 1 on the polygon. 

Which image would be better if you paste the texture on the 

polygon in short distance: [a] the image with 256x256 dots of 

resolution, or [b] another image with 64x64 dots of resolution 

(Figure 2)?  The answer is definitely not [b], because if you choose 

[b] to paste on the polygon of 200 dots, you have to enlarge the 

image by about three times and the result will be jagged and hazy 

as you see on Figure 4. If you choose [a], however, it is an easy ratio 

of shrinkage from 256 to 200 (about 4:3) to get a fine result as 

shown in Figure 3, without any visible trace of jag or blur. 

 

<Figure 4> 

[b] as enlarged to 200x200 

 
<Figure 1> 

Original Image (256x256) [a] 

 

 
<Figure 2> 

Shrunk Image (64x64) [b] 

 

 

<Figure 3> 

[a] as shrunk to 200x200 

 

Creating a MIPMAP 

1. What is a MIPMAP? 
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But how about pasting the texture on the polygon in long distance?  If the polygon is displayed in the size of 32 dots, 

for example, you want to shrink the small texture [b] to the half size (64 to 32) and paste it to get a high quality 

result, rather than go all the way to shrink the large one [a]: it does not increase image quality at all and it requires 

much computation and too many access to memory. The image [a] will be drawn much faster than [b] at a lower cost 

of CPU time and memory space. 

 

As you can see in this simulation, it sometimes occurs that you want to change the texture automatically when you 

have to paste it on a polygon in wide variety of distance. As a resolution to this problem, the MIPMAP technology is 

developed. A MIPMAP picture has a set of identical images with several different resolutions so that the process of 

selecting a texture of most appropriate size can be easily automated. 

 

When you create a MIPMAP picture, you shrink an original image by a linear rate of the half size, quarter, eighth, 

etc. in width and height. The whole process of shrinking an image to 1/2, 1/4, 1/8, and so on is not quite interesting.  

It doesn’t require a creative mind and even makes you bored to shrink the original image many times, not to 

mention the tedious work of drawing everything the half or of packing the produced images in one set: it also 

involves many image windows kept open, selecting and looking at those pictures one after another, and keeping 

restrictions for MIPMAP images most likely to be different for each of your target platforms! 
 
Fortunately, iMageStudio does provide exactly what you need to create MIPMAP picture automatically. It produces 

a MIPMAP image set as quick as a flash, and you can specify the original image data and parameters of shrinkage 

rate and other options to satisfy the requirements. 
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Restrictions to the original image for your MIPMAP may depend on the target platform. Generally speaking, you 

usually prepare an image of width and height being a power of two: 32, 64, 128, 256, etc. 

 

 

 

When you are ready to make a MIPMAP picture, choose [Create MIPMAP] item 

from [Image] menu (see Figure 1).  It will open the [Create MIPMAP] Dialog as 

shown in Figure 2. 

 

First of all, select how much you want to shrink the original image by specifying 

[Creation Range]. 

 

When you are creating MIPMAP from an Indexed Color original image, you can 

choose either to [Convert to Direct Color Image] of interpolating colors to shrink 

images, or to [Keep Original Palette] of the Indexed Color Image. 

 

For the [Output Type], it would be normally safe to choose [Multilayer Image], 

which makes easy to save the resulting images to a file. 

 

Then, you must specify the [Resize Setting]. In this pane, you first choose an 

[Interpolation Method], which determines the algorithm for shrinking. The best 

interpolation method will vary depending on the image type. So you should better 

try some method to know how these methods fit to certain images (see the HELP 

document for more information). 

 

If you want smooth Alpha Channel transition between transparent and opaque 

parts, turn [Apply Anti-Aliasing to Alpha Channel] switch ON. 

 

If you want to avoid smearing colors on a target machine, which can occur at the 

border of transparent and opaque parts on zoomed in MIPMAP with Alpha 

Channel, you should turn [Border Protector] ON. 

 

A shrunk image often seems to be blurred or obscured. To compensate this 

tendency, try the [Sharpen Filter]. 

 

Finally, click [OK] button to create the MIPMAP picture. 

 

<Figure 1> 

 

 
<Figure 2> 

2. Before you create a MIPMAP 

3.  [Create MIPMAP] Dialog 
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Note that these functions are target specific and may not be available on your iMageStudio version for other target 

machine. 

 

 

When you convert Direct Color MIPMAP images to Indexed Color Images for 

the use on specific target machine, the easiest way is to applying Color 

Reduction.  Visit the Dialog shown in Figure 3 by selecting [Color Reduction] 

from [Image] menu.  Click [Output] Tab and turn [Color Reduction for 

MIPMAP] switch ON. This way, you can apply Color Reduction to create 

Indexed Color MIPMAP images that share a common Palette between all of 

the different sizes. 

 

<Figure 3> 

 

 

When you want to convert MIPMAP images to S3TC or DXTC texture 

compression format, select [Convert to S3TC format] or [Convert to DXTC 

format] from [Image] menu (see Figure 4).  For further information about 

these formats, read the Editing S3TC/DXTC section later in this chapter. 

 

On the [Image Conversion] Dialog as shown in Figure 5, select to use or not 

to use Color Equalizer and other options, turn the “Process All Layers” 

switch ON, and click [OK] button to apply the texture compression to 

MIPMAP images. 

 
<Figure 4> 

 

 
<Figure 5> 

 

 

 

Save MIPMAP images in the specific format to be used by your target hardware platform. 

4. Format Conversion for the Target Machine 

Converting to Indexed Color Images 

S3TC/DXTC 

5. Saving MIPMAP Images 
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When you edit images with your PC, the image is displayed on CRT, Color LCD monitor, or other high-quality 

display device. When the users see the image on their game consoles, however, the image would be displayed on TV 

monitor or small low-quality LCD monitor. Since these devices have very different color characters, you can never 

expect to see exactly the same colors on your PC and the end users’ video devices. While you are developing video 

games, you have to pay attention to the color quality of user’s output devices and adjust colors for them on your PC. 

 

The iMageStudio has a function to adjust colors of your images on video games as close as possible to the colors seen 

on your PC and to output the adjusted images as final output data. This function is the Color Equalizer. 

 

As the difference of colors also depends on video circuit of the target machine as well as its monitor device, the items 

you can adjust on Color Equalizer and the adjustment range are quite different on each version of iMageStudio for 

different targets. 

 

 

Color Equalizer of iMageStudio can be used when you apply Color Reduction or 

S3TC/DXTC conversion process. Here is an example to use Color Equalizer on Color 

Reduction process. 

 

Visit [Color Reduction] Dialog box and click ColorEQ Tab. Turn [Use Color 

Equalizer] option ON to enable Color Equalizer for output. Adjust the parameters 

as needed and apply Color Reduction. That’s all!  
<Figure 6> 

 

 

When you connect supported development device appropriately to your PC and select [Remote Display] item from 

[View] menu, the image you are editing on iMageStudio will be also output to TV monitor or other remote display 

monitor through the development device. 

When the Color Equalizer is switched ON, the colors of your image might be seen somewhat “not true” on your PC 

monitor. But when you see the output on the target device via Remote Display, it looks "true” to the user’s view 

point. 

You can adjust the Remote Display parameters by visiting [Remote Display Setting] from [Options] menu. As the 

output parameters widely varies depending on the development device and the connection method, please read the 

Remote Display Manual exclusively released for your target platform and then configure the development device 

and the parameters of Remote Display function. 

Color Equalizer and Remote Display 

What is Color Equalizer? 

Using Color Equalizer 

Remote Display 
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S3TC and DXTC are compressed image formats widely used in recent game development. The basic theory is 

common to the two formats: an image divided into blocks of 4x4 dots of representing all pixels in the block by two 

Representative Colors and two Interpolating Colors. Using this Color Distribution Technique, you can compress a 

full color data up to 1/8 data size in excellent performance! 

 

The conventional graphics tools have some shortcoming to handle these formats: S3TC/DXTC compressed images 

can not be edited. So, if you find some fault in a compressed image, you would have to modify the original image and 

then compress the image again. 

 

In iMageStudio, however, editing S3TX/DXTC compressed images is possible. You can also compress any image to 

S3TC/DXTC format, read and write compressed images files as well as editing compressed images. 

 

 

 

To compress an image using S3TX or DXTC format, select 

[Convert to S3TC format] or [Convert to DXTC format] from 

[Image] menu (see Figure 7).  

 

After the compression process is over, the image window will look 

like Figure 8. For an Indexed Color Image, you will see 

S3TC/DXTC blocks in the place where the Palette Editor has 

been shown. This is called “S3TC Editor” or “DXTC Editor”, in 

which you can edit pixels in a block and also modify the 

Representative Colors in a block. In this section, let's call it “the 

editor” for short. 

 

<Figure 7> 

 

 

<Figure 8> 

 

Editing S3TC/DXTC 

1. What is S3TC/DXTC? 

2. Compress and Display S3TC/DXTC Images 
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On the editor, click on the place you want to edit, and the enlarged image 

of the clicked part will be displayed on the editor. As you can see in 

Figure 9, the enlarged image consists of a box of 4x4=16 pixels at the 

center with peripheral dotted lines, and the other pixels surrounding the 

box. The central box of 16 pixels is called Editable Block. 

 

As you edit the Editable Block, buttons below the editor change. In this 

case, the buttons are shown as you see in Figure 10. The two buttons at 

the left and right ends are named Representative Colors and the two in 

the middle are called Interpolating Colors. Note that only one button (in 

this case, the left Principal) is pushed. This means that the color 

represented by the button is currently selected. You can hit a pixel with 

the selected color by clicking the Editing Block. 

 

Click on a Principal Button and the selected Principal Color will be 

assigned to Color Chart Window (see Figure 11), where you can change 

the Principal Color. If you do this, the Interpolating Color will be changed 

accordingly, and the colors of the whole Editing Block will be updated. 

 

<Figure 9> 

 

 
<Figure 10> 

 

 
<Figure 11> 

 

 

 

You can save the edited S3TC/DXTC compressed images to the specific file format of your iMageStudio’s dedicated 

platform. 

3. “Editable Block” Operation 

4. Saving S3TC/DXTC Files 
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Batch Process with Macro 

 

Chapter 5 
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Macro Functions of iMageStudio are very handy in games production field where many image elements are handled 

at the same time. 

 

User Macros, in the sense of computing, can be largely categorized in three types: 

 

A: Described or “coded” using a programming language. 

 

B: Recorded user operation. 

 

C: Operation list created by user using graphic user interface (GUI). 

 

Macros of type A can describe operations in finest details, but it requires the user to learn the specific programming 

language. 

 

Type B may appear to be the easiest way to make a Macro. But if you have missed something or done something 

wrong while you were recording the Macro, you have to do it again from the beginning. Moreover, reusing an 

existing Macro by modifying it is not easy or impossible. 

 

Type C is the iMageStudio’s way: you can select an operation from a list, set its parameters, and set the order of the 

operations. You use the same kind of Dialog that you use in iMageStudio to give orders about the operations. 

Reusing an existing Macro is easy as well as modifying it. 

 

Macros of iMageStudio can be applied to the image you are editing right now as well as to image files. You can 

execute a Macro either from menu or by pressing a key to which the Macro is assigned. It means that an arbitrary 

combination selected from huge collection of iMageStudio functions can be easily executed by one-key operation. 

 

In this chapter, you will see Macro creation and execution. 

Macro Functions 
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There are two different ways to execute Macros in iMageStudio: Single Function Execution and Multi-Functions 

Chain Execution. 

 

Executing Single Function is simple: you just select a function, set up its parameters and execute the Macro straight 

away. This is most useful when you want to execute the same function on multiple images. 

 

Executing Multi-Function Chain, on the other hand, takes two phases: First, you specify multiple functions in a 

sequence using Dialog interface, and save the sequence to a Macro File. In the second phase, you execute the Macro 

by specifying the Macro File. In this way, you can assign a complex sequence (for example, to trim, shrink, and apply 

Color Reduction) to a Macro File. It is also possible to reuse an existing Macro File by loading, editing, and saving as 

a new Macro with different file name. Besides, you can assign the saved Macro File to an arbitrary key on your 

keyboard for shortcut execution. 

Two Ways for Executing Macros 
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Visit [Process Macro] Dialog by selecting [Process Macro] item from [Macro] 

menu (Figure 1). 

 

In this Dialog, you can select the execution type (Single or Multi-Function) 

and specify input and output settings. First of all, in this case, click the 

[Single Function Execution] button on top of the Dialog box (see Figure 2). 

 
<Figure 1> 

 

 

<Figure 2> 

 

 

 

Next, you select a function to execute: in this example, let’s select [Color 

Reduction] (Figure 3). You can specify optional parameters for Color 

Reduction by clicking [Options] button on the right side. 
 

<Figure 3> 

 

 

 

A Dialog of options settings for executing the Macro appears (Figure 4) by clicking 

[Options] button.  

In this case, you have to click [Reduction Setting] button to set Color Reduction 

parameters. 

Check [Skip Indexed Color Image] switch if you want to apply Color Reduction to Direct 

Color Images only and skip Color Reduction for each Indexed Color Image; all images will 

be output regardless of their types. 

 

If you want to output Palettes after Color Reduction besides the original Palettes, check 

[Save Palette to file for each image] switch. 

 
<Figure 4> 

Executing Single Function 

1. [Process Macro] Dialog 

2. Specify a Functions 

3. Set Options for the Function 
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Now, go back to [Process Macro] Dialog and set up Input parameters (Figure 5). 

 

In [Process Target] pane, choose target input image for Macro processing. Select 

[Files in Input Folder] to apply Macro process to files in a specific folder, [Drag & 

Drop Files] to drag and drop image files from Windows Explorer or other 

application, or [Current Image] to process the image you are editing. In this 

example, let’s select [Files in Input Folder]. 

 

To select [Files in Input Folder] as [Process Target], [Input File Setting] is required, 

in which you specify Input Folder Name and Input File Type (file extension).  

 

If you want to process images in subfolders of the input folder, check [Including 

subfolders] option. 

 

Another option, [Modified files only] is helpful when you apply the same Macro to 

the same target folder again. If this option is turned ON, iMageStudio will compare 

time stamps of files before and after the Macro Process (that is, files with the same 

name in Input and Output folders) and apply Macro process to input files of newer 

than equivalent files in output folder by skipping unnecessary process for already 

updated files. 

<Figure 5> 

 

 

Finally, in [Output File Setting] pane, set up [Output Folder] and [Output File 

Type] parameters for images after Macro process (Figure 6).  

 

You can skip Output File Setting by selecting [Current Image] as [Process Target] 

because the processed images will be output to new Editing Windows not in files. 

 

<Figure 6> 

 

 

Click [OK] button. This will start Macro process. You will see an Information 

Dialog indicating the progress of the Macro processing (see Figure 7). 

 
<Figure 7> 

 

4. Input Setting 

5. Output Setting 

6. Execute Macro Process 
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Visit [Process Macro] Dialog by selecting [Process Macro] item from [Macro] 

menu, just like you did for Single Function Execution. This time, click 

[Multi-Function Chain Execution] button on the top-right of the Dialog box to 

change the execution mode (see Figure 8). 

 

In this section, let's create a new Macro called “Shrink and CR”, the short for 

Shrink and Color Reduction. 

 
<Figure 8> 

 

 

 

From the Dialog shown in Figure 8, click [Create Macro] button to see Edit 

Macro Dialog (Figure 9). 

We are going to create a Macro which executes the following three processes: 

1. Shrink the input image to width 128 dots keeping its aspect ratio. 

2. Apply "Sharpen” filter lightly to compensate softened edges of the shrunk 

image. 

3. Apply Color Reduction process to the filtered image to output image of 256 

colors. 

 

<Figure 9> 

 

 

 

Select [Rotate/Flip]-[Resize] from the [Functions] list in the Dialog shown in 

Figure 8. Then click [Append] button to see [Macro-Resize] Dialog (Figure 10). 

 

This time, turn [Specify Width] switch ON and set the size to 128, turn [Keep 

Aspect Ratio] switch ON, and select Bilinear as [Interpolation Method].  

 

Click [OK] button to close this Dialog box and append Resize item to [Process 

List] in the Dialog as shown in Figure 9. 

 

<Figure 10> 

Executing Multi-Function Chain 

1. [Process Macro] Dialog 

2. [Edit Macro] Dialog 

3. Resize 
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Select [Filter]-[Sharpen] from the [Functions] list in the Dialog (Figure 9) and 

then click [Append] button to see [Sharpen] Dialog (Figure 11). 

 

Set [Filter Effect] to 25% (which is rather soft) and click [OK] button. 

 
<Figure 11> 

 

4. Sharpen 
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Finally, select [Convert]-[Color Reduction] and click [Append] button also from the 

[Functions] list in the Dialog shown as Figure 9. You will see [Color Reduction Setting] 

Dialog (Figure 12). 

 

The button at the top of this Dialog is for [Reduction Setting]. Click it to pop up [Macro - 

Color Reduction] Dialog box. Set [Output Colors] as 256 colors here and click [OK] button 

(Figure 13). 

 

Now you have registered the Macro process. 

 
<Figure 12> 

 

 
<Figure 13> 

 

 

 

To execute the registered Macro process, you can specify the default [Process 

Target] of this Macro in [Edit Macro] Dialog (Figure 14). The target will be 

automatically set as a default whenever you select this Macro in [Process Macro] 

Dialog And if you assign this Macro to a shortcut key, the default target setting 

will be always used. 

 

In this case, select [Current Image] as [Process Target]. 

 
<Figure 14> 

 

 

 

Now, your Macro is completed. You should save it to a Macro File: click [Save and Exit] 

button and a Dialog pops up for you to specify the Macro name (Figure 15). Type in the 

name of your Macro, “Shrink and CR” to be used as Windows file name. It means that you 

can not use “*” (asterisk) and other forbidden characters. 

 

<Figure 15> 

5. Color Reduction 

6. Process Target 

7. Save Your Macro 
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It’s a good idea to assign your new Macro to a key-combination, say [Shift] 

+ A. So you can “shrink an image in open window in iMageStudio to 

128-dot width and then apply Color Reduction to the image” in one action. 

Here is a sample procedure to assign your Macro to a key combination (see 

Figure 17): 

 

1. First, select [Key Assignment] from [Macro] menu to open [Key 

Assignment] Dialog as shown in Figure 16.  

2. You can click either [Function Key] or [Shift + Alphabet Key] 

button to assign a Macro to: click [Shift + Alphabet Key] button 

in this case. 

3. Select [Shift]+A item from the [Key] list box. 

4. Select [Macro File Execution] from [Command] list box. This will 

activate the [Macro] list box below the [Command] List. 

5. From the [Macro] list box, select the newly created [Shrink and 

CR] Macro. 

6. Click [Assign] button. This will make the Macro assigned to 

[Shift]+A combination as shown in Figure 17. 

7. Click [OK] button to close the Dialog. 

 

Now, check how it works by opening an image file. Hold down a Shit key 

and type A key. After a few moment of Macro processing, a new image 

window will appear with the image resized to width of 128 dots and 

applied Color Reduction. 

 

As you might have noticed in Figure 17, you can assign other functions, as 

well as Macros, to these keys. Assigning functions that you frequently use 

will greatly increase the efficiency of your routine work. 

 
<Figure 16> 

 

 

<Figure 17> 

 

Assigning to a Key 
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Conclusion 

 

The Final Chapter 
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Conclusion: 
Throughout the chapters in this tutorial document, we tried to show you how you can utilize iMageStudio. It is an 

Integrated Image Creation Aid, general-purpose software for professionals in 2-D image production fields NOT only 

a tool for Color Reduction or Palette Editing. 

 

OPTPiX iMageStudio was originally created to satisfy the professional needs to this kind of software. We have been 

listening to the voice of the professionals saying: 

“We have to make textures for these devices, optimizing colors and sizes for each platform.” 

“We want an editing function for this image data, which is not supported by conventional tools”. 

“We’d like to finish this routine work as fast as possible. This is tedious and boring! How can we efficiently process 

these images with minimum effort and time?” 

 

Our iMageStudio has been evolved from such remarks from many people in this industry, step by step, to meet their 

requirements. 

 

Now, after several years of progress, we still have the same principle: to improve iMageStudio for the professional 

users. We appreciate your opinion, and thoroughly examine it and discuss for adoption to the next and future release 

of iMageStudio updated versions.  While we can hear the voices coming from production fields, the evolution of 

iMageStudio never stops. 
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Support for iMageStudio Users 

Web Technology Corp. is always active to help users of iMageStudio. If you have any questions, opinions, or 

requirements about iMageStudio, please let us know any time. 

 

You can contact us from: 

The iMageStudio User Support Page: http://www.webtech.co.jp/eng/support.html 

 

Or, directly to: 

The iMageStudio Support Mail Address: iMageStudio@webtech.co.jp 

 

We also provide Answers to Frequently Asked Questions (FAQ) in our iMageStudio Web Site as well as the 

latest production information and other handy services. 

Please visit our Web Site first for details about our products: 

The iMageStudio Web Site (in English): http://www.webtech.co.jp/eng/istudio/ 
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OPTPiX iMageStudio Tutorial 
 

OPTPiX, iMageStudio and web technology are registered trademarks of Web Technology Corp. 

Adobe and Photoshop are registered trademarks of Adobe Systems Incorporated in the United States and/or other countries. 

PlayStation is a registered trademark of Sony Computer Entertainment Inc. 

Microsoft, Xbox and DirectX and the Xbox logo are either registered trademarks or trademarks of Microsoft Corporation in the 

United States and/or other countries. 

NINTENDO GAMECUBE, GAME BOY ADVANCE and GBA are trademarks of Nintendo. 

All other trademarks are the property of their respective owners. 

 

© 2004 by Web Technology Corp. 

3-30-3, Nishi-Ikebukuro, Toshima-ku, Tokyo 171-0021 Japan 

 

All right reserved.  No part of this document may be reproduced, in any form or by any means, without permission in writing from 

the publisher. 
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